Exploring Microsoft Word 2013, Comprehensive (Poatsy)

Chapter 1 Office Fundamentals and File Management

1) An operating system is:

A) technology used to access files saved in the cloud.

B) software available only on desktops and laptops, not on tablets or other small, portable devices.

C) software that directs activities of a computer.

D) an app installed on a desktop or laptop.

Answer:  C

Diff: 1

Objective:  1.  Log in with your Microsoft account

2) After you start your computer and enter your username and password, ________ displays in Windows 8.

A) the desktop

B) each Charm

C) the Mini toolbar

D) the Start screen

Answer:  D

Diff: 2

Objective:  1.  Log in with your Microsoft account

3) Which of the following is an app used to store, access, and share files and folders?

A) SkyDrive

B) Windows 8

C) Snipping Tool

D) Cloud storage

Answer:  A

Diff: 2

Objective:  1.  Log in with your Microsoft account

4) Which of the following is NOT part of the Windows 8 initial screen display?

A) User identification in the top-right corner

B) Tiles

C) The Start button

D) The Start screen

Answer:  C

Diff: 2

Objective:  2.  Identify the Start screen components

5) Which of the following is FALSE about Charms in Windows 8?

A) There are six icons that make up the Charms in Windows 8.

B) Charms can be accessed by pointing to the top-right of the screen.

C) Charms provide similar functionality to the Start button in previous Windows versions.

D) Charms can be accessed by pointing to the bottom-right of the screen.

Answer:  A

Diff: 3

Objective:  2.  Identify the Start screen components

6) Which of the following is TRUE about tiles?

A) New tiles added to the Start screen are added to the beginning of your apps.

B) Tiles can be dragged to a new location on the Start screen.

C) Tiles can be pinned to the Start screen but cannot be unpinned.

D) You can remove a tile from the Start screen by double-clicking it and clicking Unpin from Start.

Answer:  B

Diff: 3

Objective:  3.  Interact with the Start screen

7) Which of the following is TRUE about the Notification area of Windows 8?

A) It doesn't exist in Windows 8.

B) It is available as a tile on the Start screen.

C) It is displayed in the bottom-right corner of the desktop.

D) It is accessible from the Start button.

Answer:  C

Diff: 3

Objective:  4.  Access the desktop

8) If you have not made any changes to the default settings of Windows 8, which icons are available on the taskbar?

A) Internet Explorer and Snipping Tool

B) File Explorer and Internet Explorer

C) File Explorer, Internet Explorer, and Microsoft Office

D) Desktop and Start screen

Answer:  B

Diff: 3

Objective:  4.  Access the desktop

9) Which of the following is NOT an available option for a snip in the Snipping Tool?

A) Desktop Snip

B) Free-form Snip

C) Window Snip

D) Rectangle Snip

Answer:  A

Diff: 3

Objective:  4.  Access the desktop

10) Which of the following is TRUE about files?

A) Software is used to create folders, not files.

B) For a file to be accessed at a later time, it must be stored only on the computer's hard drive.

C) A digital photograph or music can be a file.

D) Files contain folders. 

Answer:  C

Diff: 2

Objective:  5.  Use File Explorer

11) Which of the following is FALSE about folders?

A) Folders can be managed in File Explorer.

B) Folders contained within other folders are known as file folders.

C) The sole purpose of a folder is to provide a location for related files.

D) Folders can be created within other folders.

Answer:  B

Diff: 2

Objective:  5.  Use File Explorer

12) Which of the following is NOT part of the File Explorer interface?

A) Navigation Pane

B) Status bar

C) Content pane

D) Address bar

Answer:  B

Diff: 3

Objective:  5.  Use File Explorer

13) By default, after you click the SkyDrive tile on the Windows 8 Start screen, which of the following items will NOT display?

A) Documents

B) Pictures

C) Public Shared

D) Libraries

Answer:  D

Diff: 3

Objective:  6.  Work with folders and files

14) In File Explorer, use the ________ key if you want to select a full range of files that are adjacent. 

A) Shift

B) Tab

C) Ctrl

D) Alt 

Answer:  A

Diff: 3

Objective:  7.  Select, copy, and move multiple files and folders

15) To select a variety of files that are not adjacent in order to delete them as a group, hold down ________ while selecting each one.

A) F1

B) Alt

C) Shift

D) Ctrl 

Answer:  D

Diff: 3

Objective:  7.  Select, copy, and move multiple files and folders

16) Microsoft ________ is most appropriate to use to create a memo for business use.

A) Word

B) Excel

C) PowerPoint

D) Access 

Answer:  A

Diff: 1

Objective:  8.  Identify common interface components

17) Which of the following is NOT a feature or function available by using Backstage in Office 2013?

A) Save a file

B) View file properties

C) Move a file

D) Close a file 

Answer:  C

Diff: 2

Objective:  8.  Identify common interface components

18) What information does the title bar of Office 2013 contain?

A) The file name and the application

B) The file name and the drive

C) The file name, folder name, and drive

D) The application and the drive 

Answer:  A

Diff: 3

Objective:  8.  Identify common interface components

19) When do contextual tabs display in Office 2013?

A) When you select a paragraph in a document

B) When you right-click the Ribbon and check a conceptual tab name

C) When you click the Home tab

D) When you select an object in a document 

Answer:  D

Diff: 2

Objective:  8.  Identify common interface components

20) Which of the following statements is FALSE about the status bar in Office 2013?

A) The status bar is located at the bottom of the Office 2013 window.

B) Contents viewable on the status bar are standard in all Office applications.

C) Slide number and total slide information are displayed in PowerPoint.

D) Summary information is displayed in Excel. 

Answer:  B

Diff: 3

Objective:  8.  Identify common interface components

21) Many dialog boxes offer a help feature by clicking:

A) the F12 key.

B) a question mark.

C) the F1 key.

D) a light bulb. 

Answer:  B

Diff: 2

Objective:  9.  Get Office Help

22) Which of the following is TRUE about the Recent Documents list in Office 2013?

A) It constantly changes.

B) It is accessed from the Home tab.

C) All files located on your hard drive can be accessed from it.

D) It can be quickly accessed with the F10 key.

Answer:  A

Diff: 3

Objective:  10.  Open a file

23) What does clicking the pushpin next to each file name on the Recent Documents list do?

A) The file will remain on the Recent Documents list for one full week.

B) The file will remain on the Recent Documents list indefinitely.

C) The file can be "pinned" to a particular folder that you designate.

D) The file is available to be "pinned" to the Quick Access Toolbar. 

Answer:  B

Diff: 3

Objective:  10.  Open a file

24) Printing a document is available from the ________ tab.

A) File

B) Home

C) View

D) Page Layout 

Answer:  A

Diff: 1

Objective:  11.  Print a file

25) When you close a document in Office 2013, what happens to the application?

A) It automatically remains open for a minimum of 10 additional minutes.

B) It also closes with the document.

C) If you close two of more documents simultaneously, the application closes; if only one document is closed, the application remains open.

D) The application remains open. 

Answer:  D

Diff: 2

Objective:  12.  Close a file and application

26) Of the four Microsoft Office 2013 programs, the ________ Home tab is the most unique and different than the other programs.

A) Access

B) Word

C) PowerPoint

D) Excel 

Answer:  A

Diff: 1

Objective:  13.  Select and edit text

27) The small dots that surround an object at each corner and in the middle of each side are known as:

A) sliders.

B) buttons.

C) handles.

D) toggles.

Answer:  C

Diff: 1

Objective:  16.  Insert objects

28) In regard to spelling and grammar in Office 2013, it is important to know that, in general:

A) you turn on the Spelling and Grammar features in all applications.

B) only a small selection of words will be checked as you type; the rest must be accessed through the Spelling and Grammar features.

C) all Office applications check your spelling and grammar as you type.

D) Word and PowerPoint check spelling and grammar as you type; Access and Excel do not. 

Answer:  C

Diff: 3

Objective:  17.  Review a file

29) It is most attractive and common that Word documents are printed in ________ orientation. Excel documents are most often printed in ________ orientation.

A) landscape; landscape

B) landscape; portrait

C) portrait; landscape

D) portrait; portrait 

Answer:  C

Diff: 1

Objective:  17.  Review a file

30) To set or change margins in a presentation, click the ________ tab.

A) Home

B) Design

C) Insert

D) Page Layout

Answer:  D

Diff: 1

Objective:  18.  Use the Page Setup dialog box

31) Windows 8 is an Intel operating system.

Answer:  FALSE

Diff: 1

Objective:  1.  Log in with your Microsoft account

32) You can log in to Windows 8 as a local network user, or you can log in using a Microsoft account, but you cannot do both in the same session.

Answer:  FALSE

Diff: 2

Objective:  1.  Log in with your Microsoft account

33) Desktop and SkyDrive are examples of Windows 8 apps.

Answer:  TRUE

Diff: 1

Objective:  2.  Identify the Start screen components

34) Charms include Mail and SkyDrive.

Answer:  FALSE

Diff: 1

Objective:  2.  Identify the Start screen components

35) When dragging a group of tiles on the Windows 8 Start screen, a light gray vertical bar displays to indicate where the new group will be located.

Answer:  TRUE

Diff: 2

Objective:  3.  Interact with the Start screen

36) The Desktop tile does not display on the Windows 8 Start screen.

Answer:  FALSE

Diff: 1

Objective:  4.  Access the desktop

37) The Notification area of Windows 8 is displayed in the bottom-left corner of the Start screen.

Answer:  FALSE

Diff: 1

Objective:  4.  Access the desktop

38) When you use the Search box in File Explorer, you must type the full search string prior to the program searching for your results.

Answer:  FALSE

Diff: 2

Objective:  5.  Use File Explorer

39) Windows 8 does not include libraries like Windows 7 did.

Answer:  FALSE

Diff: 2

Objective:  5.  Use File Explorer

40) Folders can only be created in File Explorer, not within software programs.

Answer:  FALSE

Diff: 1

Objective:  6.  Work with folders and files

41) SkyDrive can be directly accessed from the Windows 8 Start screen.

Answer:  TRUE

Diff: 1

Objective:  6.  Work with folders and files

42) When you move all files from a folder in one location to a folder in another location, the files are duplicated so that they are located in both the original folder location as well as the folder to which they were moved.

Answer:  FALSE

Diff: 1

Objective:  7.  Select, copy, and move multiple files and folders

43) Windows 8 offers a feature to show checkboxes next to files and folder names to select in order to move, delete, or copy.

Answer:  TRUE

Diff: 2

Objective:  7.  Select, copy, and move multiple files and folders

44) In Office 2013, the Help button is located on the Ribbon.

Answer:  TRUE

Diff: 1

Objective:  8.  Identify common interface components

45) By default, the Quick Access Toolbar displays above the Ribbon in Office 2013.

Answer:  TRUE

Diff: 2

Objective:  8.  Identify common interface components

46) The Zoom slider is always displayed at the far left side of the status bar.

Answer:  FALSE

Diff: 2

Objective:  8.  Identify common interface components

47) A professionally-created file such as a budget offered by Microsoft Office and often downloaded from the Microsoft Web site is known as a template.

Answer:  TRUE

Diff: 2

Objective:  10.  Open a file

48) Increasing the font size while in Print Preview by using the zoom increases the actual font size of the document when printed.

Answer:  FALSE

Diff: 1

Objective:  11.  Print a file

49) Click the File tab, and then click the Exit button to close a Microsoft Office application.

Answer:  FALSE

Diff: 2

Objective:  12.  Close a file and application

50) You can add your own buttons and features to the Mini toolbar in Office 2013.

Answer:  FALSE

Diff: 2

Objective:  13.  Select and edit text

51) When you use the Find and Replace feature in Office 2013 you can narrow the search to only find whole words.

Answer:  TRUE

Diff: 2

Objective:  15.  Use the Editing group commands

52) A picture could be a clip art item that you save from the Internet to your hard drive or cloud storage.

Answer:  TRUE

Diff: 1

Objective:  16.  Insert objects

53) The mouse pointer changes to a four-headed arrow when you resize an object.

Answer:  FALSE

Diff: 1

Objective:  16.  Insert objects

54) When using the Spelling & Grammar button to check a document, each identified error is highlighted in a pane within the window.

Answer:  TRUE

Diff: 2

Objective:  17.  Review a file

55) The Page Setup dialog box offers options to customize margins, select page orientation, and center documents vertically.

Answer:  TRUE

Diff: 1

Objective:  18.  Use the Page Setup dialog box

56) ________ is a Microsoft operating system released in 2012.

Answer:  Windows 8 

Diff: 2

Objective:  1.  Log in with your Microsoft account

57) The ________ screen is displayed after starting up your computer and entering a username and password, if necessary.

Answer:  Start

Diff: 2

Objective:  1.  Log in with your Microsoft account

58) ________ storage is technology used to store files and work with programs that are accessed through the Internet.

Answer:  Cloud

Diff: 2

Objective:  1.  Log in with your Microsoft account

59) ________ is the default location for saving files for Office 2013 applications.

Answer:  SkyDrive

Diff: 3

Objective:  1.  Log in with your Microsoft account

60) ________ are made up of five icons that provide functionality to the Start button in Windows 8.

Answer:  Charms

Diff: 2

Objective:  2.  Identify the Start screen components

61) ________ are colorful block images on the Windows 8 Start screen.

Answer:  Tiles

Diff: 2

Objective:  2.  Identify the Start screen components

62) Removing a tile from the Windows 8 Start screen can be done by right-clicking the tile and clicking ________ from Start.

Answer:  Unpin

Diff: 2

Objective:  3.  Interact with the Start screen

63) The ________ is a Windows 8 program that allows you to capture a screen display.

Answer:  Snipping Tool

Diff: 2

Objective:  4.  Access the desktop

64) ________ are folders located within other folders.

Answer:  Subfolders 

Diff: 1

Objective:  5.  Use File Explorer

65) The ________ contains five areas: Favorites, Libraries, Homegroup, Computer, and Network.

Answer:  Navigation Pane 

Diff: 3

Objective:  5.  Use File Explorer

66) The ________ bar informs a user of the current drive or folder.

Answer:  Address 

Diff: 2

Objective:  5.  Use File Explorer

67) A(n) ________ is a Windows 8 feature that allows you to share music, pictures, and libraries with other people within a home network.

Answer:  Homegroup 

Diff: 3

Objective:  5.  Use File Explorer

68) Click select all files in an open folder, press and hold ________, and press the A key.

Answer:  Ctrl 

Diff: 2

Objective:  7.  Select, copy, and move multiple files and folders

69) A(n) ________ copy of a file or folder should be copied to another drive in case the original drive is damaged or the data is lost for some reason.

Answer:  backup 

Diff: 1

Objective:  7.  Select, copy, and move multiple files and folders

70) Press the ________ key to display keyboard shortcuts.

Answer:  Alt 

Diff: 3

Objective:  8.  Identify common interface components

71) The ________ is located at the bottom of the window in Office 2013 and contains file information.

Answer:  status bar 

Diff: 3

Objective:  8.  Identify common interface components

72) The ________ key on the keyboard accesses Help in Office 2013.

Answer:  F1 

Diff: 2

Objective:  9.  Get Office Help

73) An enhanced ________ displays in Office 2013 when the mouse pointer is placed over a button.

Answer:  ScreenTip 

Diff: 2

Objective:  9.  Get Office Help

74) Predesigned files provided within Office are called ________.

Answer:  templates

Diff: 2

Objective:  10.  Open a file

75) The ________ toolbar provides a quick way to format text in Office 2013.

Answer:  Mini 

Diff: 2

Objective:  13.  Select and edit text

76) A key or feature that can be turned on or off is known as a(n) ________ command.

Answer:  toggle 

Diff: 2

Objective:  13.  Select and edit text

77) An area of memory reserved to temporarily hold selections that have been cut or copied from a document is known as the ________.

Answer:  Clipboard 

Diff: 1

Objective:  14.  Use the Clipboard group commands

78) The ________ allows you to quickly and easily copy formatting from one area of a document to another.

Answer:  Format Painter 

Diff: 2

Objective:  14.  Use the Clipboard group commands

79) The Replace button is located on the ________ tab in Office 2013.

Answer:  Home 

Diff: 2

Objective:  15.  Use the Editing group commands

80) ________ options are the settings that are in effect when an application is installed. Spelling and grammar checker as active is one example of this.

Answer:   Default

Diff: 2

Objective:  17.  Review a file

81) Match the following terms with their description:

I.
Start screen

II.
operating system

III.
Windows 8

IV.
SkyDrive

V.
cloud storage

A.
displays after starting your Windows 8 computer

B.
released in 2012

C.
used to store files and to work with programs located on the Internet

D.
an app used to store, access, and share files and folder

E.
software that directs computer activities

Answer:  A, E, B, D, C 

Diff: 1

Objective:  Multiple objectives

82) Match the following terms with their description:

I.
Charms

II.
Start button

III.
Start screen

IV.
Windows 8 app

V.
tiles

A.
designed to run in the Start screen of Windows 8

B.
colorful block images on the Windows 8 Start screen

C.
functionality similar to the Start button in previous Windows versions

D.
not a part of Windows 8

E.
made up of several tiles

Answer:  C, D, E, A, B

Diff: 2

Objective:  Multiple objectives

83) Match the following parts of the File Explorer interface with their function:

I.
Address bar

II.
Content pane

III.
Details pane

IV.
Navigation pane

V.
Toolbar

A.
shows currently selected folder or library

B.
shows properties associated with a selected file

C.
includes buttons relevant to currently selected item

D.
contains Favorites, Libraries, Homegroup, Computer, and Network

E.
navigate to other folders or libraries

Answer:  E, A, B, D, C

Diff: 3

Objective:  5.  Use File Explorer

84) Match the following keyboard shortcuts in many programs with their function:

I.
Ctrl+C

II.
Ctrl+V

III.
Ctrl+Z

IV.
Ctrl+X

V.
Ctrl+A

A.
Copy

B.
Paste

C.
Select all

D.
Undo

E.
Cut

Answer:  A, B, D, E, C

Diff: 1

Objective:  Multiple objectives

85) Match the following components of Office 2013 and their function:

I.
Backstage view

II.
Quick Access Toolbar

III.
title bar

IV.
Ribbon

V.
Dialog Box Launcher

A.
easy access to commonly executed tasks

B.
displays the current file name and application

C.
used to print, save, open, close, and share a file

D.
contains tabs, groups, and commands

E.
opens a corresponding box that provides access to precise tools

Answer:  C, A, B, D, E

Diff: 1

Objective:  8.  Identify common interface components

86) Match the following Microsoft Office 2013 features with the tab where they can be found:

I.
access Backstage view

II.
tab that automatically displays when a file is opened

III.
create a footer in Word

IV.
change the zoom level

V.
change margins in Word

A.
File tab

B.
View tab

C.
Page Layout tab

D.
Insert tab

E.
Home tab

Answer:  A, E, D, B, C

Diff: 2

Objective:  Multiple objectives

87) Match the following shortcut actions to the selection in Word or PowerPoint:

I.
double-click

II.
triple-click

III.
press and hold Ctrl while you click to select

IV.
press and hold Shift while you press the right arrow key

V.
press and hold Ctrl while you press the letter A

A.
a sentence 

B.
a paragraph

C.
one character to the right

D.
entire document

E.
a word

Answer:  E, B, A, C, D

Diff: 2

Objective:  8.  Identify common interface components

88) Match the grammar or spelling error with the Office 2013 identification or button to click:

I.
you write "there" instead of "their"

II.
you write "recieve" instead of "receive"

III.
you leave out a necessary comma

IV.
you want it to not stop on your name in the future 

V.
you want to bypass all occurrences of "daycare"

A.
Ignore All

B.
red wavy underline

C.
green underline

D.
blue underline

E.
Add to Dictionary

Answer:  D, B, C, E, A

Diff: 2

Objective:  15.  Use the Editing group commands

89) Match the following features or parts of Office 2013 to their description:

I.
contextual tab

II.
Mini toolbar

III.
title bar

IV.
gallery

V.
status bar

A.
easy access to formatting commands

B.
contains groups of commands related to a specific, selected object

C.
set of selections when you click a More button

D.
contains information relative to the open file

E.
includes file name and application

Answer:  B, A, E, C, D 

Diff: 2

Objective:  Multiple objectives

90) Match the following Microsoft Office 2013 feature with the tab where it can be found:

I.
open Office Backstage

II.
modify text

III.
create a new chart in Excel

IV.
modify an object 

V.
change margins in Word

A.
contextual tab 

B.
File tab

C.
Home tab

D.
Page Layout tab

E.
Insert tab

Answer:  B, C, E, A, D 

Diff: 2

Objective:  Multiple objectives

91) What is the default location for saving files in Office 2013 applications? Briefly describe it.

Answer:  SkyDrive is the default location for saving files in Office 2013. SkyDrive is an app used to store, access, and share files and folders.

Diff: 3

Objective:  1.  Log in with your Microsoft account

92) Describe tiles.

Answer:  Tiles are colorful block images available on the Windows 8 Start screen. When you click a tile, you will be taken to a program, file, folder, or other Windows 8 app. Tiles include the name of the app or program.

Diff: 2

Objective:  2.  Identify the Start screen components

93) When might you want to use the Snipping Tool?

Answer:  The Snipping Tool, a Windows 8 accessory program, can be used to take a screen image that can be saved, annotated, or shared into and with other programs. The Snipping Tools offers Free-form, Rectangle, Window, and Full-screen snips.

Diff: 2

Objective:  4.  Access the desktop

94) Describe the function of Homegroup in Windows 8.

Answer:  Homegroup is a Windows 8 feature that enables you to share resources on a home network. Music, pictures, videos, and libraries can easily be shared in a home network through a Homegroup. It is password protected.

Diff: 3

Objective:  5.  Use File Explorer

95) What is a theme in Microsoft Office 2013?

Answer:  A theme is a collection of design choices that includes colors, fonts, and special effects used to give a consistent look to a document, workbook, or presentation.

Diff: 2

Objective:  8.  Identify common interface components

96) Name at least four tasks that are available in Microsoft Office 2013 Backstage view.

Answer:  You can open saved files, create new files, print items, and save and close files. In Backstage view, you can also indicate options, preferences, and settings in the program you are using. You can also exit an application as well as identify file information, such as the author or date created.

Diff: 3

Objective:  10.  Open a file

97) When and how does the Mini toolbar appear in Office 2013? What is it used for?

Answer:  When any amount of text is selected within a worksheet, document, or presentation, you can slightly move the mouse pointer within the selection to display the Mini toolbar. The Mini toolbar provides access to most common formatting selections.

Diff: 3

Objective:  13.  Select and edit text

98) What can you do from the Clipboard group on the Home tab?

Answer:  You can copy and cut text as well as objects from the Clipboard group. You can also paste as well as copy and paste formats from one location in a document to another.

Diff: 2

Objective:  14.  Use the Clipboard group commands

99) What happens when you press Ctrl+F in a Word file?

Answer:  Ctrl+F is a shortcut used to find items. Ctrl+F opens the Navigation Pane on the left side of the Word document. When you type a search term in the Search Document area, Word finds and highlights all occurrences of that search term.

Diff: 2

Objective:  15.  Use the Editing group commands

100) Describe SmartArt in Office 2013.

Answer:  SmartArt is a diagram that presents information visually to effectively communicate a message. SmartArt is considered an object and can be managed independently of an underlying document, worksheet, or presentation.

Diff: 2

Objective:  16.  Insert objects
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